
Hướng dân sử dụng CorelDRAW 12  

Bài 1: Tổng quan phần mềm CorelDraw 12 

 

1.1 Khái niệm chung về phần mềm đồ họa CorelDraw 12: 

CorelDraw là một phần mềm thiết kế Đồ họa giúp chúng ta trong công việc thiết kế ra các 

tác phẩm mang tính thẩm mỹ để ứng dụng trong cuộc sống. Đó có thể là các thiết kế dùng 

trong ngành quảng cáo, tạo dáng, thời trang, ấn phẩm báo chí.v.v. Là một phần mềm khá 

thông dụng và dễ sử dụng đối với những người mới bắt đầu làm quen với việc thiết kế mỹ 

thuật trên máy vi tính, CorelDraw rất dễ sử dụng với giao diện thân thiện, tính năng của các 

công cụ đa dạng và phong phú, giúp người sử dụng có thể tìm được các cách thể hiện khác 

nhau phù hợp với mỗi nội dung mà mình mong muốn. Cùng với sự phát triển không ngừng 

của xã hội cũng như các đòi hỏi ngày càng cao và nhanh chóng của các nhà thiết kế mỹ 

thuật, hiện nay phần mềm Đồ họa CorelDraw đã có phiên bản 14 hay còn gọi là CorelDraw 

X4. Tuy nhiên trong phạm vi hướng dẫn của cuốn sách này, chúng tôi xin giới thiệu với các 

bạn học sinh, sinh viên theo học ngành May & Thiết kế thời trang phiên bản CorelDraw 12, 

là một phiên bản tương đối dễ sử dụng và thích hợp với người mới tiếp cận với công việc 

thiết kế mỹ thuật trên máy vi tính. 

1.1.1 Cài đặt CorelDraw 12 vào máy tính: 

Để cài đặt CorelDraw 12 vào máy tính bạn cần có máy tính có cấu hình phù hợp, tối thiểu là 

Pentium III 500, Ram 128 trở lên để có thể chạy được phần mềm. Cần có đĩa CD cài đặt 

CorelDraw 12. 

- Tra đĩa CD vào ổ CD của máy tính 

- Thông thường đĩa sẽ chạy tự động với tùy chọn Autoplay và bạn sẽ thấy màn hình chào của 

CorelDraw 12 xuất hiện. 

- Nếu CD không chạy tự động, (có nhiều cách để bạn có thể cài) bạn có thể vào Menu Start, 

chọn Control Panel -> chọn Add or Remove programs -> nhấp tùy chọn Add New program - 

> chọn nút CD or Flopy -> sau đó chọn đường dẫn là ổ đĩa CD ở mục Browse. 

- Bạn nhấn mục Install CorelDraw Suite 12 sẽ thấy xuất hiện mục Welcome to Corel Draw 



Suite 12 

- Trong mục Lisence Agreement bạn nhấp vào tùy chọn I Accept the term.. sau đó nhấn next 

- Trong mục Customer Information bạn gõ tên người sử dụng cũng như tên bộ phận vào các 

ô để trống, trong mục serial number bạn nhập các dãy chữ và số mà CorelDraw 12 cung cấp 

( bằng cách kích phải chuột vào đĩa CD chọn mục Serial để lấy mật mã) -> next 

- Trong mục Language bạn chọn ngôn ngữ mình muốn hiển thị, thông thường ta chọn 

English 

- Bạn chọn ổ đĩa để cài phần mềm C.DRAW 12 vào máy tính, thông thường ta cài vào ổ C. 

- Chờ máy tính Install phần mềm, cuối cùng nhấn Finish để hoàn tất cài đặt 

 

1.1.2 Cách khởi động CorelDraw 12: 

Có nhiều cách để khởi động phần mềm CorelDraw 12 sau khi bạn đã cài đặt vào máy vi tính: 

Cách 1: Nhấp đúp chuột trái vào biểu tượng phần mềm CorelDraw 12 có trên màn hình máy 

tính 

Cách 2: Vào Menu Start -> Program -> CorelDRAW Suite 12 -> CorelDRAW 12 

…Lưu ý: muốn tạo biểu tượng CorelDRAW 12 trên màn hình, thay vì chọn CorelDRAW 12 

bạn kích phải chuột tại tên của chương trình bạn sẽ nhấp vào tùy chọn Send to -> 

Desktop(creat shortcut) 

1.2 Làm việc với các trang hiện hành 

Sau khi khởi động phần mềm đồ họa CorelDRAW 12 ta sẽ thấy xuất hiện bảng sau:



 

Bạn có thể truy cập vào một trong sáu tùy chọn trong bảng để bắt đầu làm việc với 

CorelDRAW 12 

Để bắt đầu làm việc trong CorelDRAW 12 ở một trang thiết kế mới ta có thể nhấp vào tùy 

chọn New, bạn sẽ thấy xuất hiện màn hình làm việc của một trang thiết kế hoàn toàn mới. 

Giới thiệu màn hình làm việc của CorelDRAW 12: 
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- Thanh tiêu đề: hiển thị tiêu đề hay tên của tệp tin 

- Thanh menu: thanh chứa các “thực đơn” hay các tùy chọn 

- Thanh công cụ: thanh hiển thị công cụ chuẩn của CorelDRAW 12 

- Thanh đặc tính: thanh hiển thị các thuộc tính tương ứng hỗ trợ cho từng công cụ 

- Thước đo: hiển thị đơn vị đo của đối tượng trên màn hình làm việc 

- Hộp công cụ: Chứa các công cụ ứng dụng trong thiết kế của CorelRAW 12 

- Thanh cuốn: hỗ trợ trong việc di chuyển tới vùng làm việc bạn mong muốn 

- Thanh trạng thái: hiển thị các chỉ dẫn sử dụng công cụ, tình trạng của đối tượng được lựa 

http://i471.photobucket.com/albums/rr76/khottabit-uneti/sach corel/Graphic2.jpg


chọn hoặc đang sử dụng. 

- Hộp màu: chứa các tùy chọn về màu tô nền và đường viền cho đối tượng. 

1.2.1 Trang giấy và màn hình nền : 

Trang giấy là phạm vi làm việc chính của bản vẽ thiết kế, các mẫu thiết kế trên phạm vi này 

sẽ được in ra. Phần ngoài trang giấy là màn hình nền, bạn cũng có thể thiết kế trên màn hình 

nền nhưng muốn in bản thiết kế ra bạn phải đưa chúng vào trong trang giấy. Bạn có thể sao 

lưu tất cả các thiết kế hiện diện trên trang giấy cũng như màn hình nền trong một tập tin, 

nhưng cần lưu ý là phải đưa phần muốn in ra vào trong trang giấy khi bạn muốn in chúng. 

1.2.2 Con trỏ chuột: 

Con trỏ chuột là một biểu tượng luôn di chuyển đồng thời với việc bạn dịch chuyển con 

chuột máy tính, nó hiển thị tại vị trí mà bạn di chuyển con chuột. Con trỏ chuột sẽ mang hình 

biểu tượng của công cụ tương ứng mà bạn đã chọn. 



 

1.3 Thước, lưới và đường gióng kích thước: 

1.3.1 Thước – Ruler: 

Thước là một thành phần mà bạn có thể tùy chọn hiển thị hay không hiển thị trên màn hình 

làm việc của CorelDRAW: trên thanh menu bạn nhấp vào tùy chọn View, sau khi 1 flyout 

xuất hiện bạn nhấp vào tùy chọn Ruler (show ruler) để làm xuất hiện thước xung quanh màn 

hình làm việc của CorelDRAW. Để làm ẩn thước ta cũng thực hiện các bước tương tự. 

Thước có tác dụng trong việc giúp bạn xác định kích thước cũng như đơn vị đo của đối 

tượng trong bản thiết kế 
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1.3.2 Lưới – Grid: 

Lưới có tác dụng trong việc bạn thiết kế hay muốn sắp xếp các đối tượng theo một đơn vị tỷ 

lệ nhất định, ở đây lưới được hiển thị như một bảng kẻ ô vuông với các đường dọc và ngang 

đan nhau. Bạn có thể tùy chọn hiển thị hay che khuất lưới bằng cách nhấp vào tùy chọn 

View trên thanh thực đơn (menu), sau khi flyout hiện ra bạn nhấp tiếp vào tùy chọn Grid, 

ngay lập tức lưới sẽ xuất hiện trên màn hình làm việc của phần mềm. để che khuất lưới ta 

cũng có các bước làm tương tự. 
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1.3.3 Đường gióng kích thước:Đường gióng kích thước là một công cụ hỗ trợ cho bạn 

trong việc căn chỉnh một cách chi tiết vị trí của các đối tượng theo chiều thẳng đứng và nằm 

ngang, nó cũng hỗ trợ bạn trong việc “nắn” thẳng các đường mà bạn tạo ra một cách tự do. 

Để làm xuất hiện các đường going kích thước, bạn cần chọn menu View trên thanh thực đơn, 

sau đó nhấp vào tùy chọn Guidelines trong flyout xuất hiện sau đó. Đường gióng kích thước 

hiển thị trên màn hình làm việc dưới dạng các đường nét đứt, đường mà bạn tạo ra sau cùng 

và đang sử dụng sẽ có màu đỏ. Để tạo ra các đường gióng bạn cần làm hiển thị thước, sau đó 

nhấn giữ và kéo con chuột chọn từ thước ra vị trí bạn muốn gióng. Muốn tạo ra các đường 
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gióng theo chiều thẳng đứng bạn kéo từ trái qua, muốn tạo ra các đường going theo chiều 

nằm ngang bạn kéo từ trên xuống. Nếu bạn muốn bỏ bớt đường gióng nào thì nhấp chuột 

vào đường gióng đó sau đó nhấn phím Xóa – delete trên bàn phím. Nếu không muốn hiển thị 

đường gióng bạn làm quy trình tương tự như khi muốn làm hiển thị nó. 

 

1.4 Các công cụ thuộc nhóm Shape Edit: (Shape tool) 

Hộp công cụ nằm ở bên trái màn hình làm việc có chứa các công cụ hữu ích trong việc thiết 

kế của bạn. Công cụ Shape hay còn gọi là công cụ chỉnh sửa có phím tắt là F10( phím tắt 

hay còn gọi là shortcut key là phím bạn có thể nhấn trên bàn phím để tự động chuyển tới 

công cụ bạn muốn sử dụng) 

Đây là công cụ định dạng, giúp chúng ta chỉnh sửa hình dáng của các đối tượng. Định dạng 

hình chuẩn như hình chữ nhật, hình elip và hình đa giác… Ví dụ ngoài việc bo tròn các đỉnh 
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của hình vuông hay hình chữ nhật bạn có thể thực hiện các thao tác như thay đổi hình thù 

các đối tượng. Để thực hiện, bạn click con trỏ chuột vào hình mũi tên màu đen nằm ở bên 

dưới góc phải của công cụ Shape lập tức sẽ xuất hiện 1 flyout có chứa các công cụ thuộc 

nhóm Shape (như hình minh họa). 

 

1.4.1 Shape tool: 

Ví dụ bạn vẽ một hình chữ nhật trên trang giấy bằng công cụ Rectangle ( lúc này xung quanh 

hình chữ nhật xuất hiện 8 tay nắm và một tâm quay ở giữa, bạn click chọn công cụ Shape, 

khi chọn xong hình chữ nhật mà bạn đã tạo ra có hình dạng như sau: 
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- Di chuyển con trỏ chuột đến 1 đỉnh của hình chữ nhật, nhấn giữ chuột trái và kéo để bo 

tròn các đỉnh, khi đã vừa ý bạn thả nút chuột: 

 

Trong trường hợp bạn muốn biến đổi một hình elip, bạn có thể tạo ra 1 hình elip bằng công 

cụ Elipse. Sau khi bạn nhấp vào công cụ Shape bạn sẽ thấy xung quanh hình elip có đường 

bao nét đứt và có 1 nút nhỏ 
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- Di chuyển con trỏ chuột tới nút nhỏ này và kéo rê con chuột vào bên trong hình elip, bạn sẽ 

thấy hình hình của bạn biến thành hình quạt: 

 

Trong trường hợp bạn muốn biến đổi một hình đa giác, bạn có thể tạo ra hình đa giác có 5 

cạnh bằng cách sử dụng công cụ Polygon. Bạn nhấp chọn công cụ Shape: 
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- Di chuyển con trỏ chuột tới 1 tay nắm và kéo vào trong, ta sẽ thấy hình đa giác biến đổi 

như sau: 
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- Di chuyển con trỏ chuột tới 1 tay nắm và kéo ra ngoài, ta sẽ thấy hình đa giác biến đổi như 

sau: 
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Bằng cách thay đổi hướng di chuyển của con trỏ chuột theo các hướng khác nhau bạn sẽ tạo 

ra các hình đa giác tùy thích. 

1.4.2 Smudge Brush tool: 

Là công cụ có khả năng phá vỡ hoặc thay đổi hình dạng của đối tượng trên đường bao, giống 

như việc bạn dùng đầu ngón tay của mình di vào trong hay ra ngoài của 1 giọt nước vậy. 

Chẳng hạn sau khi bạn tạo ra 1 hình chữ nhật bằng công cụ Rectangle sau đó Smudge vào 

bên trong đối tượng, bạn click và giữ trỏ chuột bên ngoài đối tượng rồi kéo rê vào bên trong 

của đối tượng, ví dụ bạn có thể tạo ra như hình sau: 

 

Nếu bạn muốn Smudge ra bên ngoài đối tượng, bạn click và giữ trỏ chuột ở bên trong đối 

tượng rồi kéo rê ra bên ngoài của đối tượng, ví dụ bạn có thể tạo ra hình như sau: 
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1.4.3 Roughen Brush tool: 

Công cụ này dùng để tạo ra nét răng cưa trên biên ngoài của đối tượng. Giả sử bạn vẽ một 

hình vuông như sau: 

 

Sau đó bạn nhấp chọn công cụ Roughen Brush từ hộp công cụ Shape và nhấn giữ con trỏ 

chuột đồng thời kéo rê trên biên của hình vuông, mỗi lần kéo rê như vậy trên biên của hình 

vuông sẽ tạo ra hiệu ứng làm cho biên của đối tượng có dạng răng cưa như sau: 
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1.4.4 Free Transform tool: 

 

Công cụ này sẽ thay đổi đối tượng một cách tự do với các chức năng như dịch chuyển, xoay, 

lật… Giả sử bạn vẽ một đối tượng có dạng sau: 
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- Bạn chọn công cụ Free Transform. 

- Di chuyển con trỏ chuột đến nút trên đỉnh của hình, rê chuột theo hình vòng tròn (xoay) 

đến vị trí mình mong muốn, sau đó click nút phải chuột, bạn sẽ được hình như sau: 
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- Nếu bạn thả nút trái chuột mà không click nút phải chuột thì công cụ sẽ không nhân bản 

đối tượng cho bạn mà chỉ hiểu là bạn đã xoay đối tượng đi một góc mà bạn mong muốn như 
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hình sau: 

 

1.5 Các công cụ vẽ (dạng vec-tơ): 

 

1.5.1 Freehand tool:  

Công cụ Freehand cho phép bạn vẽ giống như vẽ phác thảo, với thao tác nhấp và rê chuột, 

công cụ Freehand sẽ tạo ra các đối tượng thong thường. 
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Để vẽ bằng công cụ Freehand bạn hãy thực hiện các bước như sau: 

- Chọn công cụ Freehand trong hộp công cụ 

- Click và kéo rê chuột theo một hình dạng bất kỳ mà bạn nghĩ hay mong muốn tạo ra, thao 

tác này giống như việc bạn cầm bút chì để vẽ lên trang giấy vậy: 

Thực hiện thao tác vẽ tự do: 

 

Sau khi nhả chuột một đối tượng vẽ thông thường đã được bạn tạo ra như hình sau: 

 

Để vẽ đường thẳng: bạn nhấp chuột tại điểm khởi đầu, nhả chuột, di chuyển con trỏ đến 

điểm cuối của đường thẳng mà bạn muốn tạo ra và nhấp chuột một lần nữa để kết thúc. Nếu 

bạn nhấn và giữ phím Ctrl trên bàn phím trước và trong khi nhấp điểm thứ 2 sẽ ép buộc con 

trỏ chuột di chuyển theo phương có góc độ là bội số của 15 độ so với điểm thứ nhất. 
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Để vẽ đường thẳng liên tục: tương tự như vẽ đường thẳng, nhưng tại điểm thứ hai bạn nhấp 

hai lần để tiếp tục vẽ, tiếp tục nhấp hai lần ở điểm thứ ba, thứ 4… cuối cùng lại nhấp chuột 

tại điểm khởi đầu để hoàn tất đối tuợng. 

Lưu ý: khi muốn kiểm tra đối tượng đã khép kín hay chưa bạn tô màu cho đối tượng, nếu đối 

tượng được tô màu tức là nó đã được khép kín. 

1.5.2 Công cụ Bezier: 

Công cụ Bezier dùng để vẽ đoạn thẳng, đường gấp khúc và điều chỉnh hình dáng đường 

cong trong khi vẽ. Công cụ Bezier cũng có khả năng vẽ các đường thẳng liên tiếp bằng cách 

nhấp chuột liên tiếp tại các điểm trên màn hình làm việc. 

 

Để vẽ bằng công cụ Bezier bạn có thể thực hiện như sau: 

- Chọn công cụ Bezier 

- Nhấp tại điểm khởi đầu để vẽ đối tượng, nhả chuột và di chuyển đến điểm kế tiếp. Nếu bạn 

muốn tạo ra đường cong thì tại điểm tiếp theo bạn nhấp giữ và kéo rê con trỏ chuột để điều 
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chỉnh đường cong tùy ý. 

 

- Để chỉnh sửa độ cong của các đoạn cong bạn có thể sử dụng Shape tool kích tại mỗi điểm, 

sau đó nhấp chuột vào các tay nắm xuất hiện tại mỗi nút để điều chỉnh. 

 

1.5.3 Công cụ vẽ mỹ thuật: - Artistic Media 
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Công cụ Artistic Media là một công cụ mạnh dùng để tạo ra các hiệu ứng về đường nét, bạn 

không phải thay đổi thuộc tính của các đường viền (như độ dày nét và màu cua chúng). 

Công cụ Artistic Media sẽ giúp bạn vừa vẽ vừa đồng thời áp dụng hiệu ứng hoặc áp dụng 

hiệu ứng cho các đường vẽ sẵn. 

Khi công cụ Vẽ mỹ thuật đưoc chọn bạn sẽ thấy trên thanh thuộc tính hiện ra năm kiểu của 

công cụ và các tùy chọn kèm theo: 
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Công cụ Artistic Media có 5 tùy chọn: 

- Preset: khi chọn Preset công cụ Artistic Media giúp bạn tạo ra đường vẽ theo các nét bút 

định sẵn, nét bút này sẽ được liên kết động (tức là nếu bạn thay đổi nét liên kết thì nét bạn 

tạo ra cũng biên đổi theo) với một đường dẫn (được tạo ra đồng thời trong quá trình vẽ). 

 

- Brush: khi chọn kiểu Brush sẽ giúp bạn áp đặt cho đôi tượng vẽ một hình thể có sẵn biến 
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dạng dọc theo đường dẫn bạn đã tạo ra. Kiểu Brush khác với kiểu Preset ở chỗ các nét bút 

được dùng có thể là các đối tượng phức tạp có nhiều màu sắc. Các đối tượng dùng làm nét 

bút được lưu sẵn và mặc định trong Brush Stroke List: 

 

Trong khi dùng công cụ Brush, bạn còn có thêm một chức năng đặc biệt là cho phép bạn 

dùng bát cứ hình vẽ nào bạn tạo ra trong CorelDRAW luuw lại để làm nét cọ, bằng cách: 

- Chọn bất cứ hình ảnh nào bằng công cụ chọn – Pick tool 

- Chọn công cụ Artistic Media 

- Trên thanh đặc tính bạn click vào biểu tượng Save Artistic Media Stroke để lưu trữ mẫu nét 

cọ, mẫu mới được lưu sẽ xuất hiện trong danh sách các nét cọ. 

- Khi muốn xóa bớt kiểu nét cọ, bạn có thể chọn mẫu trong Brush Stroke List sau đó click 

vào biểu tượng Delete. 

- Sprayer: cho phép bạn có thể gán vào nét vẽ bạn tạo ra các đối tượng là các hình ảnh có 

sẵn: 
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- Calligraphic: Là công cụ dùng để vẽ các đường nét có khả năng thay đổi bề dày dựa trên 

hướng của nét bút, hay nói cách khác là hướng của con trỏ chuột mà bạn di chuyển. Hiệu 

ứng này giốngs như việc bạn đang sử dụng một cây bút sắt để vẽ nhưng luôn giữ nguyên 

hướng ngòi bút dù di chuyển nét vẽ tới bất kỳ điểm nào. 

 

- Pressure: là công cụ được sử dụng khi bạn vẽ các đường cong vốn thay đổi độ dày dựa trên 
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lượng thông tin phản hồi từ một nét bút nhấn hoặc một bàn phím. 

 

1.6 Công cụ tô màu và đuờng contour: 

 

1.6.1 Công cụ tô màu: 

Mộ mô hình màu là hệ thống được dùng để tổ chức và xác định các màu phù hợp với một 

tập hợp các tính chất cơ bản. 
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Có nhiều mẫu màu khác nhau nhằm xác định các chỉ số màu, ví dụ: HSB / RGB / 

CMYK…Trong đó mẫu màu RGB và CMYK là hai trong số các mẫu màu được phát triển 

để phù hợp với các thiết kế số đa dạng và các trình ứng dụng đồ họa in ấn và xuất bản. 

- Mô hình màu HSB được xác định theo ba thuộc tính: 

Sắc độ = H / Độ bão hòa = S / Độ sang = B 

- Mô hình màu RGB được xác định theo ba màu: 

Red = R / Green = G / Blue = B 

- Mô hình màu CMYK được xác định theo bốn màu: 

Cyan = C / Magenta = M / Yellow = Y / Black = K 

Để chọn màu tô cho một đối tượng (phải là một đối tượng khép kín) 

- Chọn đối tượng 

- Chọn vào công cụ tô màu, nhấp vào tam giác màu đen nằm bên dưới góc phải của công cụ 

tô màu sẽ làm xuất hiện flyout, sau đó bạn chọn công cụ: 

a. Uniform fill – Tô màu đồng nhất 

Để làm xuất hiện và sử dụng được hộp tô màu đồng nhất hay các hộp tô khác bạn trước hết 

phải chọn đối tượng muốn tô màu, nếu không CorelDRAW sẽ xuất hiện hộp thoại cảnh báo 

bạn. 



 

* Model: Mô hình màu CMYK và mô hình màu RGB là hai mô hình màu chuẩn của 

CorleDRAW 

Thực hiện một trong các thao tác sau đây để chọn màu tô: 

- Sử dung chuột nhấp vào mô hình màu 

- Di chuyển thanh trượt màu – color slider lên hoặc xuống để thay đổi dãy màu đươc hiển thị 

trong vùng chọn màu nằm bên trái của mô hình màu 

- Nhập chỉ số màu trực tiếp vào các ô tương ứng của C.M.Y.K 

* Reference color: hiển thị màu ban đầu chọn – old và màu mới chọn – new 

* Add to palete: tạo một màu mới và đưa vào bảng màu của CorelDRAW 

* Name: đặt tên cho màu mới 
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b. Fountain Fill Dialog - Tô màu chuyển sắc 

 

Bạn có thể thực hiện hiệu ứng tô màu cho đối tượng từ màu này sang màu khác 

* Type: chọn kiểu tô chuyển sắc 

- Liner: kiểu tô thẳng 

- Concial: kiểu tô hình nón 

- Radial: kiểu tô hình tròn 

- Square: kiểu tô hình vuông 

* Center offset: định tâm của phép chuyển màu bằng cách nhập các giá trị tọa độ vào hai ô 

H, V đối với trường hợp áp dụng kiểu tô chuyển màu hình nón, hình tròn và hình vuông. 

* Option: - Angle: thay đổi góc tô của dãy màu 

- Steps: Xác định số bước chuyển màu 

- Edge Pad: biên nhòe 

* Color Blend: Xác định kiểu màu trung gian 

- Two color: chuyển theo hai màu, thay đổi màu ở hai hộp From và To 

Chuyển màu trực tiếp theo đường thẳng trên bánh xe màu 
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Chuyển màu ngược chiều kim đồng hồ trên bánh xe màu 

Chuyển màu theo chiều kim đồng hồ trên bánh xe màu 

* Custom: Chuyển theo nhiều màu 

Muốn tô đối tượng theo nhiều màu ta chọn vào Custom và nhấp vào 1 trong 2 hình vuông 

nhỏ ở phía góc của thanh màu sẽ xuất hiện 2 thanh thẳng nét đứt. Dùng chuột nhấp hai lần 

tại bất kỳ vị trí nào của thanh chấm này bạn sẽ thấy xuất hiện một tam giác màu đen tại đó 

và bạn có thể chọn bất kỳ màu nào trong hộp thoại màu bên tay phải và cú thế bạn có thể 

them tùy ý bao nhiêu màu theo ý muốn. Nếu các ô màu mặc định chưa đủ với mong muốn 

của bạ, bạn hãy nhấp vào tùy chọn Others ngay bên dưới hộp màu để bổ sung thêm màu theo 

ý muốn. 

 

* Presets: Các mẫu tô chuyển sắc có sẵn của CorelDRAW 

* = ; - : Lưu ; Xóa các mẫu tô chuyển sắc trong danh sách Presets 

c. Pattern Fill Dialog - Tô mầu theo mẫu tô: 

Trong CorelDRAW 12 bạn có thể chọn một mẫu tô Bitmap, 2 màu – 2 Color hoặc nhiều 

màu – Full Color. 

Để áp dụng một mẫu tô 2 mầu – 2 Color: 
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- Chọn đối tượng với công cụ chọn – Pick tool 

- Nhấp chọn hộp công cụ Fill Tool và chọn công cụ Pattern Fill Dialog 

- Chọn nút 2 Color 

- Chọn vào mẫu tô bất kỳ trong thư virnj mặc định 

- Bạn có thể thay đổi mầu của mẫu tô bằng cách nhấp vào ô Front và Back để cài đặt các 

màu khác theo ý bạn 

- Sau khi đã chọn được mẫu tô mong muốn bạ nhấp OK 

Để áp dụng một mẫu tô nhiều mầu – Full Color: 
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- Chọn đối tượng với Pick Tool 

- Nhấp chọn hộp công cụ Fill Tool và chọn công cụ Pattern Fill Dialog 

- Chọn nút Full Color 

- Chọn vào mẫu tô bất kỳ trong thư viện có sẵn 

- Nhấn OK khi bạn chọn được mẫu tô ưng ý 

Để áp dụng một mẫu tô Bitmap: 
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- Chọn đối tượng với Pick Tool 

- Nhấp chọn hộp công cụ Fill Tool và chọn công cụ Pattern Fill Dialog 

- Chọn nút Bitmap 

- Chọn vào mẫu tô bất kỳ trong thư viện có sẵn 

- Nhấn OK khi bạn chọn được mẫu tô ưng ý 

Bạn cũng có thể sử dụng công cụ Interactive Fill nằm ngay bên dưới công cụ Fill để áp dụng 

các chế độ tô cho đối tượng. Sauk hi bạn chọn công cụ Interactive Fill bạn hãy nhấp các tùy 

chọn tương ứng trên thanh đặc tính nằn ngay phía trên màn hình làm việc mà bạn đang sử 

dụng. 

d. Texture Fill Dialog – Tô màu theo chất liệu: 
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Một Texture Fill là một chế độ tô được tạo ra một cách ngẫu nhiên để bạn có thể sử dụng 

nhằm làm cho các đối tượng mang một diện mạo tự nhiên hơn. Texture Fill gia tăng kích cỡ 

của một File và sẽ mất nhiều thời gian hơn để bạn in ra. Do đó, bạn hạn chế sử dụng kiểu tô 

này đặc biệt là đối với các đối tượng có kích thước lớn. 

CorelDRAW 12 cung cấp các kết cấu xác lập trước và mỗi kết cấu thì có một tập hợp các 

tùy chọn để bạn có thể thay đổi. 

 

Để áp dụng một Texture Fill: 

- Chọn đối tượng với Pick Tool 

- Chọn công cụ Texture Fill Dialog từ hộp công cụ Fill 

- Chọn thư viện chứa kết cấu mà bạn mong muốn từ danh sách Texture Library 

- Chọn một kết cấu từ hộp texture List 

- Xem trước các thuộc tính của kết cấu trong hộp thoại Preview 
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- Bạn có thể chỉnh sửa thuộc tính của kết cấu theo ý mình bằng cách thay đổi các thông số 

của kết cấu trong muc Style Name 

- Bạn nhấp nút Option để chỉnh sủa kích thước và độ phân giải của kết cấu 

 

1.6.2 Công cụ tô đuờng viền – Outline Tool: 

 

a. Công cụ đường viền - Outline Pen Dialog 
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* Color: màu đường viền 

* Width: Độ dày đường viền 

* Style: Kiểu đường viền 

* Corners: Hình dạng góc uốn 

Việc cài đặt hình dạng góc uốn làm thay đổi các diện mạo của đường thẳng hoặc đường 

cong, đặc biệt nếu đối tượng có một đường viền rất dày hoặc đối tượng đặc biệt nhỏ. 

* Line Caps: Hình dạng đầu đường thẳng 

* Arrows: Kiểu mũi tên đầu, cuối của đoạn thẳng 

* Scale with image: tùy chọn để biến đổi kích thước đường thẳng theo kích thước đối tượng. 
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b. Chọn và chỉnh sửa một Line style: 

CorelDRAW đưa ra nhiều kiểu đường khác nhau, các kiểu đường là các dạng đã được cài 

đặt sẵn có các thuộc tính khác nhau. Chẳng hạn như nét chấm, nét chấm gạch, nét đứt… 

Việc áp dụng một kiểu đường thì không làm thay đổi hình dạng và phương hướng của 

đường. 

Để chọn một kiểu đường: 

- Chọn đối tượng với công cụ chọn – Pick tool 

- Nhấp vào công cụ Outline và chọn hộp thoại Outline pen 

- Chọn một kiểu đường viền bất kỳ trong Style 

Để chỉnh sửa một kiểu đường: 

- Chọn đối tượng với công cụ chọn – pick tool 

- Nhấp vào công cụ Outline và chọn hộp thoại Outline pen 

- Nhấp nút Edit style 

 

- Chỉnh sửa phần cuối của đường thẳng bằng cách di chuyển thanh về phía phải 

- Nhấp vào các ô vuông để mở hoặc tắt các chấm 

- Nhấp vào nút Add để bổ sung kiểu đường vào bên dưới của danh sách 

- Nhấp nút Replace để thay thế kiểu đường trước đây đã được bổ sung vào danh sách.  

c. Công cụ màu tô của đường viền – Outline Color Dialog: 

- Chọn đối tượng với công cụ Chọn – pick tool 

- Mở công cụ Outline rồi nhấp hộp thoại Outline Color 

- Thực hiện tương tự như bảng màu của mầu tô 
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d. Hộp thoại Pen – Pen Roll-up: 
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1.7 Các lệnh hiệu chỉnh, cắt xén và sắp xếp đối tượng: 

1.7.1 Lệnh hiệu chỉnh – Transformation: 

Lệnh hiệu chỉnh dùng để dịch chuyển, xoay, lật, co giãn, thay đổi kích thước và kéo nghiêng 

đối tượng một cách chính xác bằng cách nhập số. 

a. Dịch chuyển – Position: 

- Vẽ một đối tượng tự do 

- Chọn đối tượng bằng công cụ chọn – pick tool 

- Chọn thực đơn Arrange -> Transformation -> Position 
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Lúc này bạn sẽ thấy bên phải màn hình làm việc của bạn xuất hiện một hộp thoại. 

- Nhập kích thước muốn thay đổi vào hộp thoại H hoặc V 

- Click Apply hoặc Apply to Duplicate để thực hiện lệnh dịch chuyển cho đối tượng: 

o H = Horizontal: di chuyển chiều dọc 

o V = Vertical: di chuyển chiều ngang 

o Apply: thực hiện lệnh di chuyển không sao chép 

o Apply to Duplicate: thực hiện lệnh dịch chuyển nhưng sao chép đối tượng, đối tượng gốc 

vẫn giữ nguyên 

o Relative Position: xác định hướng dịch chuyển cho đối tượng 
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b. Xoay đối tượng – Rotation: xoay đối tượng quanh tâm xoay 

- Vẽ một đối tượng quanh tâm xoay 

- Chọn đối tượng với Pick tool 

- Chọn thực đơn Arrange -> Transformation -> Rotation 

- Nhập thông số vào hộp thoại Angle 

- Click Apply hoặc Apply to Duplicate để thực hiện lệnh xoay đối tượng 

o Angle: góc xoay 

o Center: tâm xoay 
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c. Co giãn và lật – Scale and Mirror: co giãn đôi tượng theo tỷ lệ % 

- Vẽ một đối tượng tự do 

- Chọn đối tượng với Pick tool 

- Chọn thực đơn Arrange -> Transformation -> Scale 

- Nhập kích thước muốn thay đổi vào hộp thoại Scale với H và V 

- Click Apply hoặc Apply to Duplicate để thực hiện lệnh 

o H – Horizontal: chiều ngang 

o V – Vertical: chiều dọc 
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d. Thay đổi kích thước – Size: theo chiều ngang hoặc chiều dọc 

- Vẽ một đối tượng tự do 

- Chọn đối tượng với Pick tool 

- Chọn thực đơn Arrange -> Transformation -> Size 

- Nhập kích thước muốn thay đổi vào hộp H hoặc V 

- Click Apply hoặc Apply to Duplicate để thực hiện lệnh 

o H – Horizontal: chiều ngang 

o V – Vertical: chiều dọc 
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e. Kéo xiên – Skew: định góc xiên cho đối tượng tính theo độ (00) 

- Vẽ một đối tượng tự do 

- Chọn đối tượng với Pick tool 

- Chọn thực đơn Arrange -> Transformation -> Skew 

- Nhập kích thước muốn thay đổi vào hộp H hoặc V 

- Click Apply hoặc Apply to Duplicate để thực hiện lệnh 

1.7.2 Cắt xén và sắp xếp đối tượng – Menu Arrange: Mối quan hệ giữa các đối tượng: 

Trong mục này xin giới thiệu với các bạn về cách xử lý mối quan hệ giữa các đối tượng – 

Menu Arrange 

a. Sắp xếp các đối tượng – lệnh Align and Distribute: 

http://i471.photobucket.com/albums/rr76/khottabit-uneti/sach corel/Graphic54.jpg


 

Bạn có thể nhận ra ngay rằng, lệnh này chỉ có tác dụng khi bạn muốn sắp xếp vị trí của từ 

hai đối tượng trở lên trong CorelDRAW. 

- Chọn hai đối tượng bạn muốn sắp xếp 

- Chọn menu Arrange / Align and Distribute 

- Hộp thoại xuất hiện 

o Top: 2 đối tượng bằng nhau phía trên đỉnh 

o Center: Bằng nhau ở giữa 

o Bottom: Bằng nhau dưới đáy 

o Left: cân nhau lề trái 

o Right: cân nhau lề phải 

o Center: Canh giữa 

o Align to Grid: So hàng các đối tượng với lớp dưới 

o Align to Center of page: so hàng các đối tượng trùng tâm của trang giấy 

o Edge of Page: so hàng các đối tượng trùng với cạnh của trang giấy 

o Lưu ý: bạn có thể canh hàng các đối tượng bằng cách chọn chúng rồi click vào nút Align 

trên thanh Property 
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b. Phân phối đều – Distribute: 

- Chọn hai đối tượng bạn muốn sắp xếp 
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- Chọn menu Arrange / Align and Distribute 

- Hộp thoại xuất hiện, chọn Distribute 

 

1.7.3 Thay đổi thứ tự các đối tượng – Order:  

Bạn có thể thay đổi thứ tự xếp chồng của các đối tượng trong cùng một lớp. Trước khi sử 

dụng bất cứ lệnh nào bạn cần phải chọn đối tượng mà bạn muốn thay đổi thứ tự bằng công 

cụ chọn – pick tool. 

- Chọn đối tượng cần thay đổi thứ tự 

- Chọn Menu Arrange -> Order 

• to Front (Shift + page up): đưa đối tượng lên lớp trên cùng 

• to back (Shift + page down): đưa đối tượng xuống lớp dưới cùng 

• Forward one (ctrl+PgUp): đưa đối tượng được chọn lên một lớp 

• Back one (ctrl+PgDn): đưa đối tượng được chọn xuống một lớp 

• In front of: đưa đối tượng được chọn lên trước một đối tượng cụ thể, bạn click mũi tên màu 

đen xuất hiện sau đó vào đối tượng muốn nằm đè lên 

• Behind: đưa đối tượng được chọn xuống dưới một đối tượng cụ thể bất kỳ bằng cách click 

mũi tên màu đen vào đối tượng bạn muốn nằm bên dưới nó. 

• Reverser order: đảo thứ tự trên, dưới của các đối tượng trên cùng một lớp, muốn thực hiện 
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lệnh này bạn cần phải chọn tất cả các đối tượng muốn thay đổi bằng công cụ chọn. 

 

1.7.4 Nhóm – Group: 

Gom nhiều đối tượng thành một nhóm, bạn đầu khi bạn vẽ các đối tượng thì chúng là những 

thành phần riêng biệt trên bản thiết kế. Khi bạn muốn cùng lúc di chuyển hoặc thay đổi kích 

thước của nhiều đối tượng cùng lúc bạn cần phải “gom” chúng lại thành một nhóm, bạn cần 

dùng lệnh Group = Ctrl+G 

- Group: nhóm các đội tượng lại thành một đối tượng để di chuyển hay biến đổi hình dạng 

đồng thời bạn cần: 

- Chọn các đối tượng muốn nhóm lại với nhau bằng Pick tool. 

- Vào menu Arrange và nhấp tùy chọn Group (hoặc nhấn tổ hợp phím tắt Ctrl+G trên bàn 

phím) 
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- Ungroup và Ungroup all: là lệnh rã nhóm mà bạn đã nhóm chúng lại trước đó. 

• Ungroup: khi bạn đã nhóm các đối tượng lại bằng lệnh Group 1 lần thì chỉ cần thực hiện 

câu lệnh Ungroup các đối tương sẽ lại tách rời nhau để bạn có thể biên đổi chúng riêng rẽ. 

• Ungroup all: Nếu trong quá trình làm bạn đã thực hiện việc nhóm các đối tượng nhiều lần : 

gom các nhóm nhỏ thành một nhóm lớn. Lúc này nếu bạn chỉ áp dụng câu lệnh Ungroup thì 

bạn chưa hoàn toàn tach tất cả các đối tượng trở nên riêng biệt…bạn cần sử dụng câu lệnh 

Ungroup All. 

1.7.5 Lệnh Combine – hòa nhập các đối tượng thành một đối tượng có chung đặc tính: 

Giả sử bạn có hai đối tượng với màu sắc khác nhau, lúc này bạn muốn chúng hòa thành một 

đối tượng có chung hiệu ứng màu tô, bạn nên sử dụng câu lệnh Combine. 

Nếu hai đối tượng nằm đè lên nhau, thì phần đè sau khi bạn thực hiện lệnh Combine sẽ trở 

nên rỗng – không có màu. Nếu chúng không có phần giao thì sẽ có chung hiệu ứng màu tô 

và bạn có thể di chuyển hay biến đổi kích thước chúng như khi bạn áp dụng câu lệnh Group 

vậy. 

- Bạn chọn các đối tượng muốn hòa nhập với nhau 

- Chọn menu Arrange ->Combine (Ctrl+L) 
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- Hoặc bạn cũng có thể nhấp nút lệnh Combine ngay trên thanh thuộc tính phía trên màn 

hình làm việc 

 

  

  

  

  

Bước 1: Vẽ nửa trên của biểu tượng hình chiếc nón  

 

- Chọn công cụ Bezier Tool   rồi vẽ các đoạn thẳng liên tiếp để tạo nên 1 hình tam giác 

 

- Chọn công cụ chỉnh node (Shape Tool – F10 )  

 

- Click chọn cạnh đáy của tam giác, trên thanh thuộc tính của công cụ Shape Tool chọn ô Convert Line to Curve  rồi uốn uốn cong đoạn thẳng này  

 

- Chọn hình rồi click chuột phải và chuột trái vào biểu tượng màu vàng để tô màu cho nền và đường viền 

 
Bước 2: Vẽ nửa dưới của biểu tượng hình chiếc nón  

 

- Tương tự bước 1 bạn chọn công cụ Bezier Tool  rồi vẽ 1 hình tam giác  

 

- Chọn công cụ chỉnh node (Shape Tool – F10 )  
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- Click chọn cạnh đáy hoặc cạnh bên trái của tam giác, trên thanh thuộc tính của công cụ Shape Tool chọn ô Convert Line to Curve  rồi uốn uốn cong 

các đoạn thẳng này  

 

- Tô màu nền và đường viền bằng màu xanh 

 
Bước 3: Vẽ biểu tượng vòng cung  

 

- Chọn công cụ 3 Point Curve Tool  rồi vẽ 2 đường cánh cung có chung điểm đầu và điểm cuối  

 

- Điều chỉnh các đường cánh cung cho phù hợp rồi tô màu vàng 

 
Bước 4: Viết chữ  

 

- Chọn công cụ Text Tool – F8  rồi viết 2 chữ là APEC và VIETNAM 2006  

 

- Chọn Font và kích cỡ chữ cho phù hợp rồi tô màu đỏ cho chữ APEC, màu xanh cho chữ VIETNAM 2006 

 
Bước 5: Hoàn thiện  

 

- Di chuyển sắp xếp các hình để hoàn thành tác phẩm  

 

- Chọn tất cả các hình, click phải chuột rồi chọn Group để nhóm tất cả các hình thành 1 hình duy nhất  



 
  

Corel Draw: Vẽ biểu tượng Hội nghị APEC Việt Nam 2006 

Từ khóa tìm kiếm: vẽ biểu tượng corel ; tô màu nền corel ; trang web ve hoi nghi apec nam 2006 ;photoshop apec ; hinh bieu tuong corel ; hdc.vn hoc ve 

corel ; font chu hoi nghi corel ; corel ghep cac duong thanh 1 hình ; bezier tool nam o day ; anh bieu tuong cua apec ;  

Vẽ chai Dove  
11:59 | 15/12/2012, Post by Administrator 

  

http://hdc.vn/timkiem_v%E1%BA%BD-bi%E1%BB%83u-t%C6%B0%E1%BB%A3ng-corel.html
http://hdc.vn/timkiem_t%C3%B4-m%C3%A0u-n%E1%BB%81n-corel.html
http://hdc.vn/timkiem_trang-web-ve-hoi-nghi-apec-nam-2006.html
http://hdc.vn/timkiem_photoshop-apec.html
http://hdc.vn/timkiem_hinh-bieu-tuong-corel.html
http://hdc.vn/timkiem_hdc.vn-hoc-ve-corel.html
http://hdc.vn/timkiem_hdc.vn-hoc-ve-corel.html
http://hdc.vn/timkiem_hdc.vn-hoc-ve-corel.html
http://hdc.vn/timkiem_font-chu-hoi-nghi-corel.html
http://hdc.vn/timkiem_corel-ghep-cac-duong-thanh-1-h%C3%ACnh.html
http://hdc.vn/timkiem_bezier-tool-nam-o-day.html
http://hdc.vn/timkiem_anh-bieu-tuong-cua-apec.html




Vẽ chai Dove 

Từ khóa tìm kiếm: vẽ chai dove bằng corel draw ; vẽ chai dau goi dau bằng corel ; vẽ bình dove photoshop ; veẽ dove ; ve4 chai dove ; ve voi corel 
dove ; ve hop dau goi dau bang corel ; ve corel chai dau goi dove ; ve chai dove bang corel ; ve chai dau goi dove bang corel ;  

CorelDraw – Rendering Face  
11:57 | 15/12/2012, Post by Administrator 

  

 

This is the step by step what i’ve done with coreldraw for my illustration, enjoy..!!   

  

http://hdc.vn/timkiem_v%E1%BA%BD-chai-dove-b%E1%BA%B1ng-corel-draw.html
http://hdc.vn/timkiem_v%E1%BA%BD-chai-dau-goi-dau-b%E1%BA%B1ng-corel.html
http://hdc.vn/timkiem_v%E1%BA%BD-b%C3%ACnh-dove-photoshop.html
http://hdc.vn/timkiem_vee%CC%83-dove.html
http://hdc.vn/timkiem_ve4-chai-dove.html
http://hdc.vn/timkiem_ve-voi-corel-dove.html
http://hdc.vn/timkiem_ve-voi-corel-dove.html
http://hdc.vn/timkiem_ve-voi-corel-dove.html
http://hdc.vn/timkiem_ve-hop-dau-goi-dau-bang-corel.html
http://hdc.vn/timkiem_ve-corel-chai-dau-goi-dove.html
http://hdc.vn/timkiem_ve-chai-dove-bang-corel.html
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Create 3D Boxes in Corel Draw  



11:55 | 15/12/2012, Post by Administrator 

  

Web:http://www.entheosweb.com/tutorials/coreldraw/3d_boxes.asp 

Learn how to create 3D boxes with sparkling effects using Corel Draw. 

 

You can use this design to create stunning banner ads as seen below. The source file for this design can be downloaded at the end of the tutorial. 

http://www.entheosweb.com/tutorials/coreldraw/3d_boxes.asp
http://www.entheosweb.com/tutorials/coreldraw/3d_boxes.asp


 

 

Tutorial Details 

 Program: CorelDraw 11 - X5 

 Difficulty: All 

 Estimated Completion Time: 30 Minutes 

 

Step 1 : Basic Elements 

First of all you have to use CorelDraw with version 11+. In this tutorial I use CorelDraw X5, Okay lets get started. Let’s take a look at the basic elements used to create 

our design : 

http://www.entheosweb.com/tutorials/coreldraw/3d_boxes.asp


 
 

Step 2 : Creating Worksheet 

Okay, now that you know the steps and elements, we will begin, first of all open your CorelDraw program, now create a new file and set the paper size to A4 and set the 

Units to pixels. 
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Step 3 : Creating the Main Boxes 

Now that we have our worksheet set, now we will begin to create the Main Boxes, first go to the " Rectangle Tool ", you can found it on the left toolbar, make a Box 

shape and resized it to 115 x 115 px. 



 

  

After that select the box and go to the upper toolbar and find Effects > Add Perspective, now you will see that there is a box frame inside the boxes, click and drag the 

corner to apply the perspective similar like below. 



 

  

Now go to the " Interactive Extrude Tool ", you can find it in the left toolbar, hold and drag the box to the upper left side to create an extrusion effect. 



 

  

Select the objects and break it by pressing " Ctrl + K " after that select the front side of the box and put color in it by go to the " Fountain Fill Tool " in the left toolbar, 

apply the value below. 



 



 

  

Now select the left and the top side of the Box, and put color in it by go the " Fountain Fill Tool " in the left toolbar, and apply the value below. 



 



 

  

Now create an outline of the box using bezier tool, similar like below, point and click to create the shape, make sure the first click is connected to the last click, or else 

you cannot put color in it. 



 

  

Put white color on the outline. 



 

  

Select the box and group it by pressing " Ctrl + G ", after that copy and rotate the box to the side using " Left + Right mouse " while holding ctrl. 



 

  

Select the copied box and put color by go to the " Fountain Fill Tool " in the left toolbar, and apply the value below. 



 



 

  

Now lets create the third box, go to the " Rectangle Tool " and create a box shape with the size of 85 x 85 px. 
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After that select the box and go to the upper toolbar and find Effects > Add Perspective, now you will see that there is a box frame inside the boxes, click and drag the 

corner to apply the perspective similar like below. 



 

  

Now go to the " Interactive Extrude Tool ", you can find it in the left toolbar, hold and drag the box to the upper left side to create an extrusion effect. 



 

  

Select the objects and break it by pressing " Ctrl + K " after that select the front side of the box and put color in it by go to the " Fountain Fill Tool " in the left toolbar, 

apply the value below. 



 



 

  

Now select the left and the top side of the Box, and put color in it by go the " Fountain Fill Tool " in the left toolbar, and apply the value below. 



 



 

  

Create an outline of the box using " Bezier Tool " point and click to create the shape, make sure the first click is connected to the last click, or else you cannot put color 

in it. 



 

  

Put white color for the ouline. 



 

  

Group it by selecting the objects and press " Ctrl + G ", after that arrange it on top of the yellow and green box. 



 

  

 

Step 4 : Working With Transparency 

Create a custom box shape using " Bezier Tool " on the front side of the yellow box. 
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We are going to make the custom box shape transparent by go to the " Interactive Transparency Tool " in the left toolbar, drag it from right top to the left bottom to create 

a linear transparency effect. 



 

  

Apply the steps above on all of the boxes. 



 

  

 

Step 5 : Creating the Background Boxes 

Okay now we are going create the Background boxes , go to the " Rectangle Tool " and create a simple box shape similar like below. 



 

  

After that select the box and go to the shape tool, you can found it in the left toolbar, left click on the corner and drag it to make the corner rounded. 



 

  

Now copy the box using " Left + Right mouse " while holding Ctrl, make the copied box bigger than the original. 



 

  

Select the original box and put color in it by go to the " Fountain Fill Tool " and apply the value below. 



 



 

  

After that select the copied box and put color in it by go to the " Fountain Fill Tool " and apply the value below. 



 



 

  

Now create a custom shape inside the purple box using " Bezier Tool " and put white color in it. 



 

  

Make it transparent using " Interactive Transparency Tool ". 



 

  

Select all the objects and group it by pressing " Ctrl + G ", after that copy it, make another 2 boxes and put any color mix that you like. 



 

  

Now Copy, Rotate and Resize the Boxes to randomize similar like below. 



 

  

Group all the boxes by selecting all of them and press " Ctrl + G ", after that arrange it behind the Main Boxes that we previously create. 

http://www.entheosweb.com/tutorials/coreldraw/3d_boxes.asp


 

  

After that copy and resize the Background boxes and arrange it on the bottom of the Main Boxes. 



 

  

Now we are going to create a sparkle for the boxes, go to the " Ellipse Tool " and create a circle similar like below. 



 

  

After that go to the " Interactive Shadow Tool " drag the circle into the objects to create a shadow, change the shadow color to white and apply the value below to create 

similar. 



 

  

Now create a star shape using " Bezier Tool " on top of the white shadow. 



 

  

Put a white color on the star shape. 



 

  

Repeat the steps above and create several sparkle for the boxes. 



 

 

Step 6 : Creating the Main Frame 

Okay now we are going to create the Main Frame, go to the " Rectangle Tool " and create a box shape with the size 300 x 250 px. 
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Put color in it by go to the " Fountain Fill Tool " and apply the value below. 



 



 

  

After that, we are going to insert the Objects into the Main Frame using " PowerClip", left-click the Objects and then go to the top toolbar and find Effect > Powerclip > 

Place Inside Container, then you will see a black arrow, Left-click it to the Main Frame, and now you will see that the Object is inside the Main Frame, you can go 

"inside" or "outside" the container by holding Ctrl while double-clicking it. 



 



 

  

We are going to create a background texture for the Main Frame, go to the " Ellipse Tool " and create a circle. 

http://www.entheosweb.com/tutorials/coreldraw/3d_boxes.asp


 

  

After that go to the " Interactive Distortion Tool " in the left toolbar and apply the value below. 



 

  

Make it transparent using " Interactive Transparency Tool ". 



 

  

Place it inside the Main frame container using " PowerClip ". 



 



 

  

  

  

  

 

Final Image 

And we are done, you can download different size for the banner in the source file section. 

http://www.entheosweb.com/tutorials/coreldraw/3d_boxes.asp


 

Download Source File 

 

 

http://www.entheosweb.com/tutorials/coreldraw/3d_boxes.asp

